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Showforge™ 1.1 and higher is required for operations within this guide, as is Firmware versions 2.0 and 
higher (gen 2 devices only). While many of the features described in this guide are applicable for the older 
WEMC-1 and ProCommander® devices prior to 2.0, not all features will perform exactly as described. Where 
possible, please always upgrade to the latest firmware via the network upgrade process as demonstrated in the 
documentation for your specific Weigl device.

Showforge™ is currently a MacOS only software package and is available for download on all MacOS laptops 
and desktop devices as a subscription from the Apple App Store and via the Weigl website for perpetual dongle 
users.

This document is provided to get your Showforge™ and Weigl system up and running as soon as possible, with 
the least amount of configuration where applicable. These instructions particularly pertain to the creation of 
animatronic or lighting shows which typically contain the following attributes in nature:

 • ArtNet/DMX lighting
 • Analog outputs
 • Servo outputs
 • 2 Channels of stereo audio
 • Digital outputs
 • Triggered on startup automatically or via up to 16 contact closures 
 • 1 timeline active at once

If your show contains more than the above configuration, please refer to additional documentation for the 
specific unit you are using, or extended Showforge™ documentation.

WHAT YOU’LL NEED
The following items are required for this tutorial:

 • Apple Computer with Showforge™ 1.1 or higher installed
 • ProCommander (any gen 2 or higher model) with firmware 2.0 or higher
 • Ethernet cable for connecting your computer to the ProCommander
 • MicroSD or SD card (based on ProCommander model being used)
 • An audio file of any native MacOS format - aiff, wav, MP3, etc.

INTRODUCTION

itms-apps://?action=discover&referrer=app-store
http://faq.weigl.support/support/solutions/articles/12000053207-showforge-
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CONFIGURING THE HARDWARE                                                                                                                                                                                     
1. Connecting a ProCommander®

Connect the Weigl ProCommander® device to the same ethernet network as your Mac that you will be using for 
both configuration and programming.

2. Computer IP Address

Verify the IP address of your computer. You’ll find this information under your Network settings or through 
various free websites, if connected to the Internet. See example in Step 3 below.

3. ProCommander IP Address Configuration

Set the IP address to match the range of your computer. Via the front panel joystick of your Weigl device (for 
example 10.0.0.xxx). Do not set it to the same address as your computer. See the Mac Network settings window 
below with the computer IP for ethernet set to 10.0.0.68.

Further information in regards to setting this IP address via the joystick can be found in the menu flow diagram 
or the user manual for each specific unit. 

NOTE: If you are using a non-joystick enabled Weigl device such as a ProCommander® ES or ProCommander® 
1/WEMC-1, please download the MacOS Configurator software from the App Store and refer to the 
ProCommander® ES Configuration section of the ProCommander® ES manual for configuration procedures via 
the Weigl Configurator application. 

BASIC CONFIGURATION

https://apps.apple.com/us/app/weigl-hardware-configurator/id1029507276?mt=12
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CONFIGURING THE SOFTWARE                                                                                                                                                                                    
1. Launch App

Launch Showforge™. This opens a new Project and Show Timeline. 

2. Save Your Project

Immediately save the project (File>Save), preferably to a folder where other elements for this project can later 
be saved as well (audio, card files, etc). A good example of file structure would be as follows:

3. Access Project Settings 

Click on the Project Settings icon  in the upper left corner of the project window to open the Project 
Settings window. This is where all project and hardware configurations will be set, as well as the process of 
exporting of final show files. 
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4. Set Main Network Adapter
This is very important for communication and file exporting to the connected ProCommander®. Click on the 
Settings tab and choose your ethernet port IP address from the Main Network Adapter list. In this example, the 
IP address of the ethernet port is 10.0.0.68. All other settings in this tab can remain as default. 

In Showforge release version 1.1 the Main Network Adapter menu has also been added to the header on the 
main screen for ease of access and monitoring. 

Note: To establish communication with the connected ProCommander® and properly deploy projects to the 
device, the computer’s ethernet port IP address to which the ProCommander® is connected must be selected 
from the Main Network Adapter list.
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5. Name Your Show
Under the Shows tab, you will see the current show listed. Click once on this to highlight and change the show 
name to something relevant for your project. 

Note: Projects can contain multiple shows, which are added and cloned in this Shows pane. 
 

6. Access the Outputs Tab

Click on the Outputs tab. This is where your connected Weigl hardware devices will be added and configured. 

7. Add Connected Devices

Click and hold on the  icon below the Project Devices field. A pop up menu will display all possible devices 
which can be added to the project. Choose the ProCommander® connected to your computer. In this example, 
we will be using the ProCommander® ES. 

               
Note: Confirm the network status indicator to the right of the added ProCommander® is green, indicating the 
ProCommander is successfully connected to your computer and Showforge via the previously chosen network. If 
the indicator is not green, check your network settings and connection.
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8. Add Device IP Address

Click on the newly added device to highlight it. A graphic representation of the rear of the device will appear at 
the bottom of the window. Next, click on the ProCommander® IP Address field and type in the correct address 
of your connected Weigl device and hit return. In our example, we are using the address 10.0.0.101, which is 
the default, as shipped address of all Weigl ProCommanders®. For most applications, the ProCommander® Port 
should remain as 5555.

Note: Clicking on the device name once will allow for the name of the device to be changed, should you choose to 
do so. 

9. Adding Multiple Device Outputs At Once

Click the  icon below the Device Outputs field and choose Add Multiple Outputs. Note the option for Add a 
Single Output as well. 
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10. Set Number of Outputs

In the Add Multiple Outputs window, fields and check boxes will now be displayed for all outputs applicable 
to the particular device we added to the project. In this example, we will click on all 8 outputs available on 
the ProCommander® ES in the Add Digital Outputs field. Note: The displayed naming prefix for each of these 
outputs for the project can be changed in the Naming Prefix fields. 

Next, click on the Add button at the bottom of the window.  

Note: The above example shows DMX channels 1-4 will be added. See the note at the end of step 12 regarding 
DMX and analog outputs. 

The added output ports will now be listed in the Device Outputs field and graphically represented on the Device 
Diagram. 
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11. Label Outputs

Let’s add a bit more description to the output labels for reference to our specific project. Click once on Digital 
Output 1 to highlight and add “Mouth” to the label. Repeat for digital outputs 2-4 adding Head Nod, Eyes Left 
and Eyes Right respectively. Your final configuration should look like this:

12. Test the Digital Outputs

Click on one of the configured digital outputs in the Device Outputs list and click the Enable Test check box. 
Actuating the Digital Test button should trigger the digital output at the connected ProCommander®, shown by 
the level indicators on the ProCommander® display.

Note: The Output pane is also where DMX and analog channels can be added. The ProCommander® model will 
determine which output options are available for digital, DMX and analog, as well as additional settings for each. 
These options are listed at the Output Type pull down menu as each added output is highlighted. 
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All further timeline mapping and programming procedures as related to digital outputs in this guide can also be 
applied to DMX and analog outputs and programming.

13. Add Input Devices

Click on the Input tab and note the devices listed in the Detected Hardware field. More than likely, you will 
see an Apple keyboard and possibly a Trackpad listed here, assuming these devices are part of your currently 
connected Apple Desktop computer or laptop. If you have another preferred programming input device such 
as an X-box controller, lighting board, etc., it could be plugged into the computer at this time and recognized 
by clicking Refresh. For this example, we have added an X-box style joystick as an additional input device for 
reference          

   

Note: Showforge™ currently supports most Mac-compatible USB HID devices, as well as Behringer X-touch 
Universal Control Surfaces, Mackie devices and ArtNet input over ethernet. 

Once the preferred input devices are listed, triggering any button, slider or joystick direction, will immediately 
register live in the Status window as green  when triggered and red  when idle. 
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14. Capturing a New Input Button

Click on the  icon and choose Add Hardware Input from the drop down menu. Then click the Capture New 
button. 

              

15. Select and Save

For this tutorial, choose the Z key by pressing it on the keyboard once to acknowledge and then click the Save 
button. 

                

16. Add Additional Inputs

Repeat this for X, A and S keys for a total of four configured inputs and then click the Close button to exit the 
Project Settings window. 
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Note: Clicking once on the listed input will allow for the description to be changed, if so desired. Analog inputs 
via joysticks and similar devices for programming analog outputs and DMX are outlined in the Showforge™ 
manual. 

16. Save Your Work

This would be a good time to save your work if you haven’t done so already. File>Save. 
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BASIC TIMELINE CONFIGURATION

ADDING AUDIO                                                                                                                                                                                     

1. Set to Edit Mode and Add an Audio Track

With the hardware and project configurations now set, let’s prepare our show for some basic programming. 
Ensure the timeline is in Edit Mode by clicking on the Edit Mode button  in the center of the timeline. 
You will see an open zone just below the Time Display. This is where audio tracks will be housed. To add an audio 
track, click the Add Audio Track  icon or right click directly on the Audio Track Zone and select Add Audio 
Track from the pop-up menu.

      

or

      

Note: Hovering the mouse pointer over buttons and icons will reveal their function.

2. Renaming Audio Tracks

An audio track will be added to the timeline as well as listed in the Layout tab in the Properties pane in the lower 
right. The audio track can be renamed by clicking once on the Audio Track 1 listed in the Layout tab. 
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3. Importing Audio Files

Let’s add some audio for programming. Click on the Audio tab in the Properties panel. Then click the  icon 
or right click in the audio pane below the  and  icons to bring up the Add Audio Files pop up menu . 

  

or

   

4. Navigate to the Audio File Location

This will bring up a file browser window. Navigate to an audio file on your computer which could be used for this 
exercise and click Open to import. 

Note: Showforge™ supports most MacOS native audio formats for import including MP3, WAV, AIFF and AAC.
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5. Inserting the Audio File On the Timeline

The audio file will now be listed under the Audio tab. Click and drag the audio file from the Audio tab to 00:00 
on the Audio Track.  

Note: Imported audio will be automatically saved as part of the project file. Therefore, there are no links to 
external files and or a local copy required once imported. 

6. Mapping Audio to Output Device

Audio tracks added to a timeline must be mapped to an output device for the audio to export during 
deployment. Click on the audio track header to highlight it. The Properties pane will display the Audio Input 
Channels and Target ProCommander pull down menus, as well as check boxes for selecting Channel Target 
Outputs. In our example, the audio file imported is stereo. With the below settings, this stereo file has been set 
to our target ES ProCommander® with the Left Channel Target Output as 1 and the Right Channel Target Output 
as 2, meaning that upon deploying the project to a ProCommander®, the left channel of the stereo audio file will 
play through audio output 1 and the right channel of the stereo audio file will play through audio output 2 at the 
ProCommander®.  

Note: Audio on the timeline must be mapped to Target Outputs to be included as part of the project deployment.
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7. Playback Via the Transport Menu

Pressing the space bar or the Play button  in the Transport Menu above the timeline will now initiate the play 
cursor which will play the audio in real time as the cursor passes over it in the timeline. Pressing the space bar 
again or the Stop button  (replaces the Play button  while playing) will stop the play cursor. Clicking 
the Jump to Beginning button  will return the playhead to the beginning of the timeline. 

ADDING GROUPS AND TRACKS                                                                                                                                                                                     
1. Adding Groups

It’s time to add some Data Tracks to house our output cues. Data Tracks are organized into Groups, so we must 
first create a Group. This can be accomplished by clicking the Add Group  icon or right clicking in the lower 
open area in the timeline and selecting Add Group from the pop-up menu.

   

 

or
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2. Adding Data Tracks

With the new Group added to the timeline, we can now populate it with Data Tracks. There are two ways to do 
this. Click the Add Data Track  icon at the right end of the Channel Group header or right click directly on the 
Channel Group header and choose Add Track from the pop-up menu. 

    
or  

  

3. Name the Group and Data Tracks

The Group and the Data Track it contains will now be shown on the timeline and in the Layout tab. Click once on 
the Channel Group 1 listed in the Layout tab and rename it as “Robot Head.” Do the same for the New Track 1 
and rename it “Mouth.”
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MAPPING INPUTS AND OUTPUTS TO THE TIMELINE                                                                                                                                       
1. Map an Input Device and Output to a Data Track

Click on the newly labeled Mouth data track, highlighting it in red. In the Properties panel, select an input 
device from the Track Input menu and Digital Output 1-Mouth from the Primary Output menu.  In our example, 
Keyboard Key Z has now been mapped to Digital Output 1-Mouth. 

  

2. Add Additional Data Tracks and Map

Repeat the process of adding three more Data Tracks by clicking on the Channel Group 1 track header and 
assigning the tracks to inputs and outputs as follows:
 Head Nod - Keyboard X, Digital Output 2-Head Nod
 Eyes Left - Keyboard A, Digital Output 3-Eyes Left
 Eyes Right - Keyboard S, Digital Output 4-Eyes Right

Note: Outputs can also be mirrored by clicking the Mirrored Outputs + button and 
choosing another track from the pull down menu. This can be useful if, for example, 
two outputs need to trigger simultaneously - possibly a digital head turn left on an 
animatronic actuating simultaneously with the digital eyes left movement. 

If you make a mistake, don’t worry. The Undo  and Redo  buttons provide 
multiple levels of correction. Unwanted tracks can also be selected in the timeline 
and deleted by hitting the  button or the Delete keyboard key.
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The completed configuration should look like this:
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BASIC ANIMATION PROGRAMMING - EDIT MODE

RECORDING OUTPUT CUES                                                                                                                                                    

1. Set Timeline to Edit Mode

There are two modes or approaches to programming in Showforge™ (Live Mode and Edit Mode), with the ability 
to jump between either mode at any time by clicking the Live  or Edit Mode  buttons just below 
the Audio Track. 

You will likely find that bouncing between both modes during the programming process can be very efficient 
and useful. So far, we have been working in Edit Mode to configure the timeline. For demonstration purposes, 
we will stay in the Edit Mode to more quickly familiarize you with the relationships of inputs and outputs to the 
timeline. Confirm the timeline is in Edit Mode .
 

  

2. Prepare to Record Some Data Cues

Let’s record some animation points. To do this, be sure the Master Record button  above the timeline is 
blinking, indicating it’s armed. Also, be sure the Network Link button  is set to active (indicated by a blue 
outline) to initiate communication with the connected ProCommander.® Click on the Track labeled Mouth to 
highlight it in Red. Then click on the Track Status Indicator at the right end of the Mouth track header which 
should currently be in the Off state. This is where we set the status of the track for recording and 
playback. Set the Mouth track to Record .
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3. Return the Playhead to 00:00

The Mouth track is now ready to record. Return the playhead to 00:00 by either dragging it or clicking the Jump 
to Beginning Transport button . 

Remember, we mapped the Mouth track to the Z key on our keyboard and Digital Output 1-Mouth, which is 
displayed in the Properties window with the Mouth track highlighted.

  

4. Initiate Recording

Hit the space bar and note the red recording envelope which is being created in the Mouth track as the 
playhead moves down the timeline and plays the audio file in Audio Track 1. 
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While the playhead is moving, hit the Z key several times. Note the digital output nodes being laid down on 
the track as the Z key is pressed. Digital Output 1 should also be simultaneously triggering on the connected  
ProCommander®, which will be indicated by a bar on the front of the ProCommander® display. 

5. Playback Review

Hit the space bar to stop the playhead. Note the Mouth track is still in Record Mode, indicated by the red shade 
of the envelope. Click on the Record Mode  on the Mouth track header and set it to Play . The track is now 
in Playback Mode, indicated by the newly created envelope changing to green. We can now review our newly 
recorded outputs in Playback Mode. Return the playhead to 00:00 and hit the space bar. Watch the recorded 
Digital Output 1 triggering on the ProCommander® display as the playhead passes over the nodes in the track 
envelope. 

         

6. Repeat For Additional Tracks

Repeat the above process to record outputs on the Head Nod, Eyes Left and Eyes Right tracks as well. Note, any 
number of tracks can be set to Record Mode  simultaneously while others remain either in Off or 
Play Mode , allowing for any combination of existing outputs, and those currently being recorded, to be 
previewed in real time at a connected animatronic figure.  
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7. The Record Mode

Return the playhead to 00:00 and set the Mouth track to Record Mode  again. 
Hit the space bar to begin recording. Note the previous outputs recorded on the 
Mouth track are now being erased as the playhead passes over them. Hitting the 
Z key will lay down new output nodes. 

You’ll notice there are several different modes of recording under the Track 
Status Indicator, each behaving differently during recording and playback. 
We’ll explain each of these further in the Programming with Envelopes and 
Track Modes section, but first let’s look at the Live Mode  approach 
to programming. 
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BASIC ANIMATION PROGRAMMING - LIVE MODE

RECORDING OUTPUT CUES                                                                                                                                                                                     

1. Set Timeline to Live Mode

While Edit Mode  is a timeline based view, Live Mode  offers a more heads up approach, focused 
specifically on the direct relationship of inputs vs. outputs in a programing soft console view.

Click on the Live Mode  button at the center of the timeline. You will now see all Data Tracks 
represented as panels. Immediately above this is an abbreviated view of the timeline, containing only the Audio 
Track and Time Display. 

Each Data Track Panel contains a Primary Output Status Indicator, a Track Status Indicator, and an I/O Status Field 
listing the mapped input device key, as well as the mapped output. 

2. Record Some Output Cues

Similar to the Track Status in Edit Mode, clicking on the small Track Status Indicator  icon will reveal the same 
Track Status options. Choose Record Mode  for the Mouth and hit the space bar to begin recording. Use the Z 
key to create some output cues. 
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3. Playback Review 

Hit the space bar to stop the playhead. Click again on the Track Status Indicator for the Mouth and select 
Play . Return the space bar to the beginning of the timeline and hit the space bar again to watch the playback 
of the newly recorded Mouth cues. Each cue is represented by the Output Status changing from a red for 
inactive to green state  for active as the playhead passes over the cues in the timeline.  

Similar to Edit Mode  , in Live Mode  any number of tracks can be set to Record Mode  
simultaneously while others remain either in Off or Play  Mode, allowing for any combination of existing 
outputs and those currently being recorded to be previewed in real time at a connected animatronic figure.   
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MASTER RECORD BUTTON

ENABLING AND DISABLING MULTIPLE TRACKS VIA MASTER RECORD BUTTON                                                         

1. Set Tracks to Record

Up to this point, we’ve demonstrated programming by individually toggling the Track Status of each Track into 
Record  and Play Mode . By utilizing the Master Record Button , a more global method is possible. This 
is accessible in both Live  and Edit Mode , but we will demonstrate in Live Mode. 

While in Live Mode , set the Track Status to Record Mode  for both Eyes Left and Eyes Right. Note the 
Input Device Status indicating the mapping for each of these tracks, which in this case is keyboard key A and S. 

2. Record Some Output Cues

Enable the Master Record Button , indicated by a blinking status, return the playhead to 00:00 and hit the 
space bar to begin recording. Use the A and S keys to record outputs for the Eyes Left and Eyes Right tracks. 

3. Disable Master Record For Playback Review

Hit the space bar to stop the playhead and return it to 00:00 so we can review what you just recorded. However, 
instead of toggling the Eyes Left and Eyes Right Track Status to Play Mode  for review, as we previously 
demonstrated, click the Master Record Button  to temporarily disable Master Record Mode (indicated by a 
non-blinking status). Now hit the space bar to review the newly programmed outputs. 

Since we have the Master Record Button toggled to off, the Eyes Left and Eyes Right output cues can be quickly 
reviewed without recording over the outputs. This method also saves time by eliminating the need to toggle 
each track individually to Play Mode status, providing a more efficient way to jump in and out of a record state, 
especially when multiple tracks or groups are being programmed simultaneously.  

Note: A keyboard shortcut can also be defined for quicker toggling of the Master Record Button.
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ENVELOPES AND TRACK MODES

TRACK MODES - RECORD MODE                                                                                                                                           
To dramatically speed up the programming process, Showforge™ offers simple, yet powerful envelope tools 
which can be combined with a selection of Track Modes. Let’s look at this process by utilizing one Track Mode 
we’re already familiar with - the Record Mode .  

1. Create an Envelope Start Marker

We need to create a few Markers in our timeline. Hover the mouse pointer over 00:00 in the Time Display and 
double click. This will create a Marker.

        

2. Set Start Marker to Loop

In the Properties panel, click on the Marker Type pull down menu and select Transport and then LoopStart as 
the Transport Type for the newly created Marker. 

    

3. Create an Envelope End Marker

Create another Marker around 5 seconds down the timeline, at 00:00:05:00 and select Transport and LoopEnd 
in the Properties pane. We have now created a looping envelope for which we will demonstrate  Track Modes. 
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4. Set the Track to Record

To better demonstrate the function of the Track Modes, toggle to the Edit Mode . Then, enable the 
Master Record Button (indicated by a blinking status). The Eyes Left and Eyes Right tracks should still be 
in Record Mode  from the previous exercise, but if not, set them as such and return the playhead to the 
beginning of the timeline.

 

5. Record and Review Output Cues

Press the space bar to begin recording. Using the A and S keys, record some output cues onto the Eyes Left and 
Eyes Right tracks. As the playhead reaches the Loop End Marker, you will notice that it automatically returns to 
the Loop Start Marker and toggles the Eyes Left and Eyes Right tracks to Play Mode , allowing for immediate 
review of the output cues just recorded. This is one possible mode for recording and reviewing output cues with 
envelopes. 

6. Experiment With Other Track Modes
Experiment with all of the above Track Modes to fully understand the available options for recording output 
cues. See the next section for a summary of all options. Note in Live Mode , the Track Mode is indicated 
by an icon in the lower left corner of the Data Track Panel which can be quickly toggled by clicking on the icon. 
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AVAILABLE TRACK MODES

There are three other possible Track Modes for recording and reviewing outputs - Live, Latch and Touch. Here is 
the complete list of all modes and related functions:

TRACK MODE BEHAVIOR NOTES

Off
All outputs for the specified track are turned off 
for playback

Can be used to isolate tracks and their associated 
outputs which may not be desired during playback

Record
Writes over any existing outputs, returns Track 
Mode to Play upon reaching Loop End Marker

Allows for quick automated review of outputs, 
however does require tracks to be set back to 
Record for revisions

Play
Playback of all outputs within track

Live

A non-destructive mode for rehearsal or testing 
purposes (no outputs recorded), triggers outputs 
when playhead is both active and inactive

Helpful for quick testing or rehearsal of outputs 
without recording new outputs or affecting any 
existing, playhead does not need to be actively 
playing to trigger outputs

Latch
Writes over any existing outputs, Track remains in 
Latch Mode upon looping rather than returning to 
Play Mode

Allows for quick repeated recording of outputs, must 
manually toggle to Play Mode for review of outputs

Touch

Does not actively record outputs until assigned 
input device is activated, stopping playhead will 
toggle to Play Mode until input device is activated 
again

Allows for repeated quick recording and review of 
outputs in one single mode, also allows for efficient 
“jumping in” at any time during playback to touch 
up outputs

UTILIZING THE RECORD AND PLAYBACK RANGES                                                                                    

The programming process can be further streamlined by toggling on the Record and Playback Ranges , 
allowing for a quicker, individual adjustment of both a play and record range at the top of the timeline. Refer to 
the Showforge™ manual for further details. 
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EXPORT TAB SETTINGS                                                                                                                                                              

Once a show has been created, it can be exported to files for playback on Weigl ProCommander® devices. We 
will now review this process. 

1. Access the Project Settings Export Tab 

Be sure the current project is saved (File>Save). Next click on the small Project Settings icon in the upper left 
corner of the project window to open the Project Settings window and choose the Export tab.

2. Add a New Export Profile

Click the  icon to add a new Export Profile and click once on the Export Profile 1 text and rename it to 
something relevant to your project. For this example, we will name it “Animation Project Export.”

EXPORTING THE PROJECT
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3. Show Details

The right side of the Project Export window is populated with all available options for exporting the show. 
Scrolling down, you will see Show Details, ProCommander Options, CONTROL.INI Options, and Deployment 
Options. Let’s start at the top with Show Details. Check the Animation Main Show box to include your newly 
created show in the export files. If more than one show exists, all would be listed here, with an option to select 
them for inclusion. Also check the Auto-Start option. Then choose Remote Input as the Trigger. Leave the Input 
Number as 1, the Run Mode as Normal and the Event as Close. This will create a show which triggers upon 
closing Remote Input #1 on the ProCommander®.

There are several other types of Triggers with accompanying options which are discussed in detail in the 
Showforge™ manual.  

4. ProCommander® Options

Scroll down to the ProCommander® Options section and choose your connected device from the Target 
ProCommander® for Export drop down menu. Leave Audio Format as AAC, DMX Update as Mixed and Ease-In 
Time as 0. Also leave the boxed checked for Synchronized Audio Tracks to Start at 0:00. 
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5. CONTROL.INI Options

Scroll down to CONTROL.INI Options. This section sets whether the Control.INI file is auto-generated and/or any 
other additions are to be added. For this example, leave the boxes checked for both Include CONTROL.INI File in 
Export and Include Auto-Generated CONTROL.INI Content. 

Notice the !i1c!rsn1# code which has been auto-generated. This is the ASCII code for the options we set 
under the Show Details section: on close of input 1, run show 1. Refer to the Weigl ASCII Commands sheet for 
additional ASCII codes which can be manually added to the CONTROL.INI via the Include Additional Custom 
CONTROL.INI Content option. 

6. Deployment Options

Scroll down to Deployment Options. This section sets the target location(s) of the card files being created. 
Click on the Browse button next to the Local Backup Path field which will display a navigation window. Create a 
folder labeled Cards in your project folder and select it as the target by clicking the Select Local Backup Location 
button. 
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DEPLOYMENT                                                                                                                                                                              

1. Deploy the Project

With our Project Export Settings configured, you will notice all three Deploy buttons on the bottom of the 
window are now active (no longer grayed out). Be sure a MicroSD card (or SD card, depending on your device) is 
inserted in the ProCommander® and click the Deploy to Both button.
 

2. The Export Progress Window

An Export Progress Window will appear as the card files are created, card formatted and final files transferred 
to both the ProCommander® SD card and the local file folder we created. The duration of this process will vary 
based on the amount and complexity of the shows and associated audio files.

3. Test Your First Project!

Once completed, you can check your work. The card files should be both in the card folder we set in 
Deployment Options, as well as on the SD card in the connected ProCommander®. Refer to the wiring diagram 
in the associated manual for your ProCommander device for information on triggering input 1 at the rear of the 
device. Once triggered, show 1 should play with the programmed outputs and audio, which can be confirmed 
on the ProCommander® front display.  

Congratulations! You’ve just successfully created and deployed your first animation show.



Page 34

For further information and support, please visit the
 Weigl Online Support and Solutions Center.

http://faq.weigl.support/support/home
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